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1 Setting up your account for the first time 

When you first use SAS EG 8.1 you will need to set up your account by following the process outlined 

below. After you have completed this process your account will be ready for use and you will not need 

to complete this again (unless you want to update your password at a later date).  The detailed steps 

are listed overleaf. 

 

Please note: If your account is inactive for a period of 12 months, it will be automatically disabled, 

even if your project in the BioGrid Access Request System has not expired. This practice is now part 

of BioGrid’s data and information security policy. If you require your account to be reactivated, please 

email access@biogrid.org.au with your username and project details including the BioGrid project 

reference, e.g. BG-YYYYMM/99, project title and project principal investigator. 

Change SAS password
https://eg.biogrid.org.au/RdWeb/

Pages/en-US/password.aspx

Using Internet Explorer log 
into SAS using the link

https://eg.biogrid.org.au/RdWeb

with new password

Enter new password

Process for first time access

Set defaults

Operating 
System

WindowsMac

Open Microsoft Remote 
Desktop

Select Remote Resources 
(version 8) or Workspaces 

(version 10)

Enter password again and
select Ok

Enter:
URL: https://eg.biogrid.org.au/

RDWeb/Feed/webfeed.aspx
Username: bg\yourusername

Password: yourpassword

Click  Refresh 

Select SAS EG from the 
Remote Resources

Select SAS EG from the 
Remote Resources and 

select  Connect 

Log in to BioGrid system
https://apps.biogrid.org.au/forgot/

itim/self/Login/Logon.do

New password must be 12 
characters and contain upper and 

lower case lett ers and numbers

  

mailto:access@biogrid.org.au
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1.1  Change Your BioGrid SAS password 

1. Click, or copy and paste into your browser, the URL below to change your BioGrid SAS 

password 

https://apps.biogrid.org.au/forgot/itim/self/Login/Logon.do 

2. Login with your username and first-time SAS password provided to you by BioGrid Australia 

3. Answer the five security questions that appear and click submit. 

4. Under Related Tasks at the bottom of the screen, select the link for the “Tivoli Identity 

Manager Home”. 

5. Select change password. 

6. Enter your first-time password (section 2) and your new password (section 4) and select OK. 

Your password needs to be 12 characters long and include a mix of upper and lower case 

letters and at least one numeric character. 

7. You will see a “Request Submitted” confirmation, your password has now been changed.  

8. Log-off from the BioGrid system. 

 

 

 

 

  

https://apps.biogrid.org.au/forgot/itim/self/Login/Logon.do
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1.2  Launch SAS EG – W indows 7,  8 and 10.  

1. Open Microsoft Internet Explorer (Version 6 or later is required) 

2. Navigate to the website https://eg.biogrid.org.au/RDWeb  

a. Log in with your username and password  

In the domain\username field, enter your username with the domain prefix bg\ i.e. “bg\username” 

  

 

3. If you receive the following prompt, select “Allow” 

 

 
 

1. If you have changed your password as per section 2.1 select the SAS Personal Login 

Manager 9.4 

 
2. When prompted to run SAS Personal Login Manager 9.4 as a RemoteApp, press “Connect” 

3. The following connection profile will appear, click ok 

 
 

4. You should now see the logins defined for your user as per the below image:  

https://eg.biogrid.org.au/RDWeb/
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5. Double click on the defaultAuth user, the edit login properties box appears  

6. Enter your new password in the Password and confirm password boxes 

7. Click ok 

8. Close the SAS Personal Login Manager 9.4 program 

9. Return to the website opened in step 2 

10.  Select the SAS Enterprise Guide 8.1 icon  

 
11.  When prompted to run SAS Enterprise Guide as a RemoteApp, press “Connect” 

 
 

12.  When prompted, re-enter your Username and password, ensuring you enter bg\ before your 

username i.e. bg\username 

 

 

 

13.  Once complete, SAS Enterprise Guide will appear as a program on your local computer 

taskbar. 

14.  If you changed your password as per 1.1 or have not logged on after the SAS Enterprise 

Guide upgrade to 8.1 a popup will appear to re-enter your password 
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15.  Enter the following details: 

 

Username: bg\username  

Password: Enter your new password 

 

 
 

  



 

 

INT_SAS_UG_1.4.2  Page 8 of 25 

1.3  Launch SAS EG – MAC Operat ing System 

For remote desktop version 8 refer to 1.3.1, for version 10 refer to 1.3.2.  

1.3.1  Remote Desk top Vers ion 8 

1. Open Microsoft Remote Desktop (requires at least version 8.0.6). If you do not have this 

installed you can download this application from the Apps Store.  

2. Select the Remote Resources button 

3. Enter the details: 

URL: https://eg.biogrid.org.au/RDWeb 

Username: bg\username (Your username will be provided by BioGrid) 

Password: yourpassword  

4. Click Refresh 

5. Click the red X button in the top left of the pop up 

6. If you have changed your password as per section 2.1 select the SAS Personal Login 

Manager 9.4 

 

7. When prompted to run SAS Personal Login Manager 9.4 as a RemoteApp, press “Connect” 

8. The following connection profile will appear, click ok 

 
9. You should now see the logins defined for your user as per the below image:  

https://eg.biogrid.org.au/RDWeb/
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10.  Double click on the defaultAuth user, the edit login properties box appears 

11.  Enter your new password in the Password and confirm password boxes 

12.  Click ok 

13.  Close the SAS Personal Login Manager 9.4 program 

14.  Return to Microsoft Remote Desktop 

15.  From the Remote Resources that will appear, select SAS Enterprise Guide 8.1 

16.  If you encounter a message to Verify Certificate, please press Continue and SAS EG will 

launch  

17.  Once complete, SAS Enterprise Guide will appear as a program on your local computer 

taskbar. 

18.  If you changed your password as per 1.1 or have not logged on after the SAS Enterprise 

Guide upgrade to 8.1 a popup will appear to re-enter your password 

 
Enter the following details: 

 

Username: bg\username  

Password: Enter your new password 
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1.3.2  Remote Desk top Vers ion 10 

1. Open Microsoft Remote Desktop If you do not have this installed you can download this 

application from the Apps Store. 

2. Click on workspaces 

3. Click add workspace button 

4. Enter: https://eg.biogrid.org.au/RDWeb/Feed/webfeed.aspx 

5. The application will search for the workspace 

6. Click user accounts dropdown 

7. Select Add user account 

8. Enter the details: 

 Uername: bg\username (Your username will be provided by BioGrid) 

 Password: yourpassword 

  

9. Click Add, this will return you to the add workspace screen 

10.  Click add 

11.  The setting up workspace will appear 

12.  If you have changed your password as per section 2.1 select the SAS Personal Login 

Manager 9.4 

 
13.  When prompted to run SAS Personal Login Manager 9.4 as a RemoteApp, press “Connect” 

14.  The following connection profile will appear, click ok 

 

15.  You should now see the logins defined for your user as per the below image:  

 

16.  Double click on the defaultAuth user, the edit login properties box appears  

17.  Enter your new password in the Password and confirm password boxes 

18.  Click ok 

19.  Close the SAS Personal Login Manager 9.4 program 

20.  Return to Microsoft Remote Desktop 

21.  Select the SAS Enterprise Guide 8.1 icon  

https://eg.biogrid.org.au/RDWeb/Feed/webfeed.aspx
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22.  Once complete, SAS Enterprise Guide will appear as a program on your local computer 

taskbar. 

23.  If you changed your password as per 1.1 or have not logged on after the SAS Enterprise 

Guide upgrade to 8.1 a popup will appear to re-enter your password 

 
24.  Enter the following details: 

 

Username: bg\username  

Password: Enter your new password 
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2 Using SAS EG 8.1 

2.1  User Interface Overview 

The user interface is divided into five areas:  
 

1. Navigation Panes - contains different panes like the Project, Servers, and Tasks panes to 
assist you while working on your project or program.  

2. Content Area - provides the main work area. You can open as many tabs as you like, 

arranging them and docking them in any configuration.  
3. Tools Area - displays the Submission Status and Search panes below the content area by 

default.  

4. Profile Connection Indicator – indicates the active connection profile.  

5. Status Bar - shows information about the active project and item. 
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2.2  Preference Changes  

There are a few changes to make to the default settings that will enable a better experience using 

SAS EG. 

2.2.1  Change default  s torage 

The SAS default output storage is set to EGTASK. This will save a copy of all queries, outputs and 

work that you create. However this is resource intensive and will quickly slow your analyses down. 

We suggest you change this default to WORK which will save your instructions/process flow, but does 

not store all the temporary tables. These can easily be re-created when you open a project and run 

the process flow and this has the benefit of updating your analyses with the latest data from the 

library. 

1. From the Tools menu, select Options 

2. Select the Output Library in the Left-hand menu 

3. Select WORK and then click the Up button until this appears at the top of your list  

4. Move SASUSER to be the second in the list. 

5. Your list should now appear as in the figure: 

6. Click OK 
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2.2.2  Projec ts  

SAS Enterprise Guide 8.1 does not requires working with a project.  Projects are a convenient way to 

group and organize related SAS content (programs, data references, process flows, results, and so 
on). However, you might just want to work with .sas files or simply open data sets for viewing, without 
a project. You now have the choice!  

 
By default, SAS Enterprise Guide 8.1 does not start up with a project open, however this can be 
changed in the start-up options (Tools > Options > Start Up). The selectable options are: 


• No project or program. Selected by default. Start with no project or program.  

• New program only. Start with a new empty program, so you can immediately begin coding.  

• New project only. Start with a new project.  

• New project and program. Start with a new empty program in a new project, so you can 

immediately begin coding in a new project.  
 

2.2.3  Create a new projec t  

Use one of these four ways to create a new 

project:  
 

1. Select File > New > Project.  

2. Select the new icon () on the top toolbar, 
and then select Project.  

3. On the Start Page, select Create new 

project.  
4. From the Project pane, select Create a 

New Project.  
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2.2.4  Save locat ion 

To save your project work: 

1. From the File menu, select “Save “Project Name” Project As” 

2. Click on the SAS Folders on the left-hand side menu 

3. Click browse 

4. Select the folder labelled “My Folder” and save your projects here.  

 

 

This folder is only visible to you, and has the benefit of being able to be accessed from any computer 

you connect to the network, so you can work on your project from multiple locations. 

 

2.2.5  To export  data 

If you would like to export your data to work in another statistical software program you can first 

create the tables you need using the SAS EG program, or export each table separately.  

1. Right click on the table in the Process Flow  

2. Select share -> export 

3. You can then select where to save the table to, and the file format you require (.csv, .txt, .xlsx, 

.tab, .sas7bdat) 
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2.2.6  Update/replace l ib rary 

 If you have a project detailed for one library that you would like to copy the queries to another library, 

or if you need to update your library linkage after a SAS display name change, you can do so with one 

simple change within your project. Some SAS Library Display Names have changed in SAS EG 8.1 

and you may need to work through this process for projects created in 

SAS EG 4.3. 

1. Open your project file in SAS EG 8.1 

2. From the Tools menu, select Project Maintenance 

3. SAS will prompt you to close your project, select close and 

continue. 

4. The Project Maintenance window appears for your Project. This 

lists the libraries used in your Project. Select the library that you 

want to change.  

5. You can now select Replace in Project to change the source library.   

 

 

6. From the list of libraries that appear, select your new library name. 

7. Select Save.  

All changes to the library have now been saved in that Project.  You can repeat this for any Project 

that needs to be updated. 

The Process flow will now run with the connection to the new/updated library.   

  

YOUR_LIBRARY 

WORK 

YOUR_LIBRARY 

SAS:\Servers\SASApp\Libraries 

SASApp 

YOURLIB 

YOUR_LIBRARY 
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3 Useful tips for SAS EG 

SAS EG can appear quite different to many other statistical analysis software programmes, however 

– once you know how to navigate your way around EG you will be creating graphs and t -tests in no 

time. 

3.1  General Tips  

To become familiar with the SAS EG platform it can take a bit of exploration. Some tips that are useful 

if you are new to running SAS EG through BioGrid are listed below. If you have any additional tips to 

share, please let us know! 

 

1. You can have multiple process flows within one project. This allows you to keep your 

analyses organised and can reduce run time when you need to update or produce one part of 

the analysis only. Add these to your Project through the File menu, New, Process Flow. 

 

2. CTRL+ALT+END will bring up the option to open task manager for the remote desktop 

connection if you need to force SAS to close and restart.  

 

3. If you need to repeat the same analyses with a new library, make a copy of your project then 

use the update library function detailed on section 2.2.6 to save in set-up time. 

 

4. The task functions are repeated in the left-hand menu for 

quick access if you select the third icon. The other icons are 

also useful for accessing your SAS Folders or the SAS 

Libraries that you have access to. 

 

 

 

 

 

 

5. If you encounter any issues, or problems performing the task you need in SAS EG, make use 

of the SAS documentation at http://support.sas.com/documentation/94/index.html or the SAS 

forums at https://communities.sas.com/community/support-communities 

  

http://support.sas.com/documentation/94/index.html
https://communities.sas.com/community/support-communities
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3.2  Where is  my data? 

When you first open EG you are presented with a blank looking screen with a standard menu bar and 

shortcuts/navigation pane on the left.  

 
Unlike other software, if you head to the menu bar to choose, file open, you will not be able to find 

your data. Instead, SAS stores its data on a Server which is linked to the source database. This 

enables you to access real time data – anytime there is an update it will be accessible here. This 

prevents you having multiple data copies and avoids the potential for preparing out of date results or 

confusing the latest information. SAS calls this data connection to a source database a “Data Library”.  

3.2.1  Open your data l ib rary 

Head to the Navigation pane, it should show the Server List as on 

the right. If you do not have this showing, select the server icon 

(highlighted in blue) to view the server list. 

Expand the Server list by clicking the > beside Servers 

 

 

 

 

 

 

 

 

You will now see the yellow and blue libraries icon.  

Select the > beside the Libraries icon to expand the list of libraries 

you have access to. 

Depending on what approval was attained for your project, you may 

have one or multiple libraries listed. 

To view the Tables in the libraries, click the + beside the library name 

and this will show you all tables you have access to in the navigation 

pane. 

The Process Flow – Your workspace 
Navigation pane 

Menu Bar 
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For example, on the right, in the Diabetes Sample library there are four 

different tables of data listed. 

To view the data, double-click the table you are interested in.  

This will add the table to your process flow, and open the table to view the 

data. 

 

 

You will now see the data in a more familiar format. 

You can return to your Process Flow by selecting the process flow tab. 

 

Explore the setup of your tables, the columns and use your Database dictionary and schema to assist 

your understanding the relationship of your tables within your library. 

  

Use this tab to navigate back to your process flow or click on the other tabs open to view the data 
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3.3  Exploring data 

Now that you can view your data, there are several ways to explore your data.  

3.3.1  Graphs  

When you have a table open, there is another 

menu bar that is available. One of your options is 

Tasks. You can select the tasks button, then 

browse and this will open the task window. From 

this window you can expand graph list and select 

the Bar Chart Wizard, or select the options 

required using the bar chart option. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The graph will open automatically once prepared, or you can 

open it by double-clicking the SAS Report – Bar Chart from 

your Process Flow.  

 

3.3.2  Filter and Sort  

Using the filter and sort option you can reorganise the 

information in the table and limit it to the rows you require 
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3.3.3  Describe 

To create summary statistics, frequency counts and table 

analyses use the options in the describe menu 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.3.4  Analyze 

Within the task menu you will find the statistical 

comparisons tests, such as ANOVA, multivariate analysis, 

regression etc. You can use the search box to filter the 

tasks of interest. 
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3.4  Query  Builder 

To create more complex comparisons, or to combine information from several tables you will need to 

use the Query Builder. 

The Query Builder allows you to select only the 

columns you require, calculate new columns, recode 

existing columns, sort and filter data and join columns 

from other tables.  

 

 

You can select columns, by dragging and dropping into the select data tab window. To choose a filter 

column, select the filter data tab and drag and drop the column you want to filter by. 

The sort data tab allows you to choose the column to sort by.  
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3.4.1  Joining Tab les  

The benefit of using the SAS EG system is it makes it easy to work with relational databases. For 

example one patient may have, no treatments, one treatment or multiple treatments. This makes it 

difficult to store in a single table (or spreadsheet) so this is stored in more than one table. However 

when it comes to the analysis, you will need to bring the information from each table together.   

Within the Query Builder, select the Add Table 

button: 

A list of all tables in your project will appear – select 

the table you want to join. 

SAS will select the method to join the tables by using 

a common column.  

You will need to check the method by selecting the 

Join Tables button 

 

Usually the join is made using the USI number, table 

identifier and/or dataset/database identifier – if you 

need to select another column, you can specific how 

the tables are joined, in what order and any other 

filter methods required. You can also add further tables through the Join Tables window also.  

 
Once you have selected your options, click close, check your columns are selected and then hit Run. 

Be sure to check that the output is what you expected – any differences in row numbers from your 

expectation probably means your join type needs adjustment 

If you encounter any technical issues, or need any assistance, contact us at enquiries@biogrid.org.au 

4 Further Support and Training 

mailto:enquiries@biogrid.org.au
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BioGrid offers ad-hoc training and support for new or experienced SAS users to enable users to have 

sufficient knowledge of the SAS tools to conduct your own data querying, manipulation and analyses.  

BioGrid provides access to SAS tools for BioGrid members and collaborators and encourages users 

to benefit from these tools to assist in auditing, analysing and reporting your data.  

Training/Support of “how to” can include but is not limited to:  

 

 General overview of SAS 

 Querying 

 Filtering 

 Calculated fields 

 Complex joins 

 Macros 

 Data analysis tools (Descriptive statistics, Survival Analysis, ANOVA etc.) 

 

The training sessions are provided through a desktop sharing web application i.e. Join.Me, Go to 

Meeting etc. 

 

To access training please contact BioGrid at enquiries@biogrid.org.au. 

 

If researchers are unable to utilise the SAS tools for themselves and require data analyses to be 

conducted, BioGrid can provide this service to members and collaborators under a fee-for-service 

arrangement. Contact us at enquiries@biogrid.org.au if you wish to obtain a quote for this service. 
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